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SUPPLIER HOSTED CATALOG GUIDANCE



Overview

» Hosted catalogs simplify the work of our suppliers and employees of Cooper Standard.

» Hosted catalogs allow Cooper Standard employees to order goods and services on pre-negotiated terms and
prices.

« This document was created to show suppliers how to create a catalog in the Coupa Supplier Portal.

« This document will explain how to maintain the catalog by the Supplier.
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Supplier Hosted Catalog Process

Supplier login into
Coupa Supplier
Portal (CSP)

Supplier ask CS for
invitation link

Supplier to create
CSP account

Download catalog
template from CSP
(Catalog tab)

Fill all necessary
data int your catalog

Prepare your file for
uploading into CSP

Cooper Standard

Supplier

Upload your catalog

\4

Cooper Standard’s
Corporate Buyer to
approve catalog

<, CooperStandard

Catalog is visible in

Cooper Standard’s
COUPA

Maitaining Suppliers
catalog




CREATION OF CATALOG IN CSP
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1. Please logininto COUPA Supplier Portal (CSP)*:

https://supplier.coupahost.com/

Register

gecoupa supplier portal

First Name
Last Name
Company

* Email

New to Coupa? Create your account or click here for help.

Log In

Welcome back! Login or click here for help.

* Email Address | Email Address

*Password | Password

Forgot Your Password?

<, CooperStandard

* If you don’t have CSP account yet — please ask coupasupplierhelpdesk@cooperstandard.com for invitation link.



https://supplier.coupahost.com/
mailto:coupasupplierhelpdesk@cooperstandard.com

2. Please click on Catalogs:

z,scoupa supplier portal

Action needed: Complete your profile to get paid faster and get discovered Leam More

RAFAL~ = NOTIFICATIONS @ | HELP v

Home  Profile  Orders  Service/Time Sheets @ ASN  Invoices  Catalogs Add-ons  Admin

Announcements viewai o

Profile Progress Last Updated
L] 21% Complete @ 5 days ago i M erge ACCO U ntS

3. Please click on Create:

z,zcoupa supplier portal

Home Profile ~ Orders  Service/Time Sheets = ASN Invoices = Catalogs

RAFAL~ = NOTIFICATIONS @  HELP ~

Add-ons Admin

Catalogs

dl0g Name Created Date ~ Submitted Date Start Date Expiration Date
I No rows.

Perpage 15 45 40

Select Customer Cooper Standard

Status  Unanswered Comments Error Actions

Configure Punchout

(;}_;_;CooperStandard



4. Fill fields below:

TEST Catalog e Customer: Cooper Standard — filled automaticaly
Customer Cooper Standard Catalog Name — mandatory field
" Catalog Name | TEST Catalog Status Draft — filled automaticaly, will be changed after
Status Draft confirmation
Start Date [l date when catalog prices become effective Start Date — optional field

date when catalog prices become expired

Expiration Date

Expiration Date - optional field

Currency |EUR )
Currency — mandatory field

5. Load from file:

Items Included in Catalog

Name Part Number Status Change Price Price Change Currency Other Fields Changed Actions

I Mo rows.

Perpage 15 45 90
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6. Click Download -> CSV for Excel

Bulk Load Item Updates for TEST Catalog

Follow these steps to upload items

1. Download the CSV templatg, or export the current list.
Download ~ | Or Export v

CSV plai
21 i fige. Click here for a description of the required and optional fields in the template.

» (Click Start Upload and the system will attempt to load the first 6 rows from your file and show the results.

<, CooperStandard

Open file: | Thispc > Deskiop > TEST

item_list.csv ~ Name

item_list

ER STAML




7. Data -> Textto Columns

AutoSave (@ off) -

itemn_list - Excel

File Home Insert Page Layout Formulas ] Data JReview View Help  Fuzzy Lookup  Power Pivot O Search

[bE From Text/CSV [(% Recent Sources & | ] Queries & Connections

2 m AV
E [%me Web [%Existing Connections /[ Lz
Get

g2
Refresh — Stocks  Geography | = Z| Sort  Filter
Pata ~ S From Table/Range Al- [3 - | &l \& Advanced
Get & Transform Data Queries & Connections Data Types Sort & Filter
1 - b Supplier Part Num®,"Supplier Aux Part Num","Name™*","Description®","Price™®","Currency™","UOM code™*","active™®","Item Classificat]
Quantity","Order Increment”,"Contract Number","Contract Term","Savings %","Manufacturer Name","Manufacturer Part Number”,
(Tier 6)","Price (Tier 7)","Price (Tier 8)","Price (Tier 9)","Price (Tier 10)","Price (Tier 11)","Price (Tier 12)","Price (Tier 13)","Price (Tier 1
A B C D E F G H I ] K L M M 0 P

. Supplier Pa_lrt Num®,"Supplier Aux Part Num","Name*","Description®","Price™®","Currency®","UOM code*","active™*","Item Classification Name","UNSPSC Code","Lead Time'

T

8. Delimited -> Next -> unmark Tab -> mark Comma -> Finish

Convert Text to Columns Wizard - Step 1 of 3

? b4 Convert Text to Columns Wizard - Step 2 of 3 ? X
i The Text Wizard has determined that your data is Fixed Widith. This screen lets you set the delimiters your data contains. You can see how your text is affected in the preview below.
u

; If this is correct, choose Next, or choose the data type that best describes your data.

Delimiters
Original data type

Choose the file type that best describes your data:

D Semicolon |:| Treat consecutive delimiters as one
d: - Characters such as commas or tabs separate each field, omma
- = - - = - - Text gualifier: | " B
Fixed width - Fields are aligned in columns with spaces between each field. ES
D Other:

Data preview
Preview of selected data:

fupplier Part Num*, "Supplier Aux Part Num","Name*", "Description*","Price*", "Currenc:

upplier Part Num* [Supplier Aux Part Num Name* Description* Price* Currency* UCM code

Ao efe o |

>

Cancel < Back | Mext > I Finish I

(<, CooperStandard




AutoSave (@ Off) ") - item_list - Excel

File Home Insert Page Layout Formulas Data Review View Help  Fuzzy Lookup  Power Pivot 0O Search
[D' From Text/CSV [D‘ Recent Sources i i N7 = HFa
B ® [“5:’ [ Queries & Connections @ U:]j Al 7TA Y =
z
[% From Web [E] Existing Connections [=] ALz 54 (9 E! Ref
Get Refresh — Stocks Geography | = Z Sort Filter Textto o
Data - ES From Table/Range Al- [ - | &l \&Advanced | Columns E© D3
Get & Transform Data Queries & Connections Data Types Sort & Filter
F10 v Jx
A . B . C . D . E F . G . H . I . J . K . L . M . N .
1 |Supplier Pe Supplier Aux Part Num Name*  Descriptiol Price™ Currency® UOM code active® ltem Class UNSPSC Ci Lead Time Manufactt Minimum ( Order Incr
2

9. Now please fill mandatory fields with your data:
l. Supplier Part Num (column A)
II.  Name (column C)
lll.  Description (column D)
V. Price (column E)
V. Currency* (column F)
VI. UOM code* (column G)
VIl. active (column H)
VIIl. UNSPSC Code (column J)
'€ CooperStandard IX. Supplier Item English Name (column BP)



Fields description— Part 1

This will help you fill out the fields in the item bulk loader.
Supplier Part Num Required Supplier Part Numer
Supplier Aux Part Num Optional Supplier Auxiliary Part Number
Name Required ltem Short Name
Description Required Full ltem Description
Price Required ltem price for supplier
Currency Required ltem price currency. Must exist and be active in Coupa.
UOM code Required Avalid UOM code that has already been configured in Coupa
active Required Existing supplier items will be destroyed if set to No
Item Classification Name Optional ltem Classification Name that has already been configured in Coupa
UNSPSC Code Optional United Nations Standard Products and Services Code
Lead Time Optional ltems Lead Time in Days
Manufacturer Optional Manufacturer name
Minimum Order Quantity Optional Supplier Minimum Order Quantity
Order Increment Optional Supplier Order Increment
Contract Number Optional Contract Number. Must exist in coupa
Contract Term Optional The Contract Term by which the pricing tier is decided. Created beforehand in Coupa
Savings % Optional Savings %
Manufacturer Name Optional Manufacturer name for unigue identification of item with manufacturer part number
Manufacturer Part Number Optional Manufacturer part number for unique identification of item with manufacturer name
Price (Tier 1) Optional Price at different contract spend tiers. Typically goes down as more items are purchased
Price (Tier 2) Optional Price at different contract spend tiers. Typically goes down as more items are purchased
Price (Tier 3) Optional Price at different contract spend tiers. Typically goes down as more items are purchased
Price (Tier 4) Optional Price at different contract spend tiers. Typically goes down as more items are purchased

<, CooperStandard



Fields description— Part 2

Link 5 Title

Link 5 URL

Image 0 Url
Image 1 Url
Image 2 Url
Image 3 Url
Image 4 Url
Image 5 Url

Use Pack Weight
Pack Quantity
Pack Weight

Pack Weight UOM
Met Weight

Net Weight UOM
Receive Catch Weight
Item Number

Optional
Optional
Optional
Optional
Optional
Optional
Optional
Optional
Optional
Optional
Optional
Optional
Optional
Optional
Optional
Optional

If adding URL Links, This is the Title of the Link

If adding URL Links, This is the URL of the Link

If adding images, This is a valid and publically accessible URL for an image
If adding images, This is a valid and publically accessible URL for an image
If adding images, This is a valid and publically accessible URL for an image
If adding images, This is a valid and publically accessible URL for an image
If adding images, This is a valid and publically accessible URL for an image
If adding images, This is a valid and publically accessible URL for an image
Has the item calculate with the Pack Weight instead of item weight
Quanitity of items in a pack

The weight of ane pack

The UOM for a Pack

The weight of one item

The UOM for one Iltem

Forces the item to be received as catch weight

Item Identification Number

<, CooperStandard
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Currencies availablein COUPA with codes:

_Code | ___________Name | Enabled

BRL
CAD
CHF
CNY
CZK
EUR
GBP
INR
JPY
KRW
MXN
PLN
RON
RSD
SEK
SGD
USD

Brazil, Brazil Real

Canada, Dollars

Switzerland, Francs

China, Yuan Renminbi

Czech Republic, Koruny

Euro Member Countries, Euro
United Kingdom, Pounds
India, Rupees

Japan, Yen

Korea (South), Won

Mexico, Pesos

Poland, Zlotych

Romania, New Lei

Serbia, Dinars

Sweden, Kronor

Singapore, Dollars

United States of America, Dollars

Please remember to use only curencies from the list.

<, CooperStandard

TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE

13



Unit of Measures available
in COUPA with codes:

Please remember to use
only UoM from the list.

CH

CM

CX

Case

CONTAINE
R

CENTIMET
ER

COIL

<, CooperStandard

TRUE

TRUE

TRUE

TRUE

BX

DZ

CS

PK

HR

CT

KT

PD

RM

AY

BC

BD

BG

BL

BO

Each
Box
Dozen
Case_1
Pack
Hour
Carton
Kit

Pad

Pair
Ream
ASSEMBLY
BUCKET
Bundle
Bag
BLOCK

Bottle

TRUE

TRUE

TRUE

TRUE

TRUE

TRUE

TRUE

TRUE

TRUE

TRUE

TRUE

TRUE

TRUE

TRUE

TRUE

TRUE

TRUE

GA
GR
GS

HU

KG
LB

LF

LT

LY

MT
MTR
OoP
P3

P4

Feet
Gallon
GRAM
Gross

Hundred
Pack

INCH

KILOGRA
M

Pound

LINEAR
FOOT

LITER

LINEAR
YARD

METRIC
LONG
TON
Meter
2-Pack
3-Pack

4-Pack

w w W

o W W

Eleven
Code Active Pack TRUE

TRUE
TRUE
TRUE

TRUE

TRUE

TRUE

TRUE

TRUE

TRUE

TRUE

TRUE

TRUE
TRUE
TRUE
TRUE

TRUE

mmn TRUE

P8
PA
PC
PL
PT
RE

RL

SF
SH
ST
SV

B

TH
TP
UN

YD

MON

6-Pack
8-Pack
PAIL
Piece
Pallet
PINT
REEL

Roll

SQUARE
FOOT

Sheet
Set
SKID

Tube

Thousan
d

10-Pack
UNIT

YARD

Months

TRUE
TRUE
TRUE
TRUE
TRUE
TRUE
TRUE

TRUE

TRUE
TRUE
TRUE
TRUE

TRUE

TRUE
TRUE
TRUE

TRUE

TRUE 14



UNSPSC CODES (Commodity codes) are mandatory field.

United Nations Standard Products and Services Code (UNSPSC) is a taxonomy of products
and services for use in eCommerce. It is a four-level hierarchy coded as an eight-digit number.

Our suppliers can download excel file with all UNSPSC code here:

https://www.cooperstandard.com/sites/default/files/Public%20Data/Supplier UNSPSC C

odes Mapping3.pdf

<, CooperStandard

J
UNSPSC Code

J

UNSPSC Code

31411904
31411905
27112838
44101601
23240000
24101635
27111701
27131512
31161500
31410000
31411700
12161802
12161807
12161809
14111510

Examples:

31411904 Rubber on metal or plastic molded seal
31411905 Silicone molded seal

27112838 Cutting disc
44101601 Paper cutting machines or accessories
23240000 Metal cutting machinery and accessories
24101635 Screw jacks

27111701 Screwdrivers

27131512 Pneumatic screwdriver

31161500 Screws

31410000 Seals

31411700 Mechanical seals

12161802 Suspensions

12161807 Gel stabilizers

12161809 Silicone gel

14111510 Plotter paper 15


https://www.cooperstandard.com/sites/default/files/Public%20Data/Supplier_UNSPSC_Codes_Mapping3.pdf

Catalog with data:

AutoSave (@ o) ) -

item_list - Excel

File Home Insert Page layout Formulas Data Review View Help Fuzzy Lookup  Power Pivot O Search
[r'f; From Text/CSV [%9 Recent Sources P E Queries & Connections AJ, 7 | A Y 57 = ,?EE Flash Fill B= Consolidate
[% From Web [%] Existing Connections G [=] @ U:U z 2k ) S2 E! Remove Duplicates l_:]
D(:f;- E From Table/Range Riflrlefh m Stocks  Geography | < ﬂr Sort. | Fiter EAdvanced C-[:)thnzas 55 Data Validation ~ rﬁlManage Data Model
Get & Transform Data Queries & Connections Data Types Sort & Filter Data Tools
BW17 v I
A C D E F G H J AN BP BU
1 |Supplier Part Num* Name* Description™® Price* Currency®* UOM code* active* UNSPSC Code Image Url Supplier Item English Namd
2 123456-1 Test ltem 1 Item only for testing1 100.3 EUR PC Yes 31411904 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg Item only for testing 1
3 |123456-2 Test ltem 2 Item only for testing2  15.15 EUR PC Yes 31411905 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg Item only for testing 2
1123456-3 Test ltem 3  ltem only for testing3 2222.3 EUR PC Yes 27112838 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg Item only for testing 3
5 |123456-4 Test ltem 4  Item only for testing4  789.99 EUR PC Yes 44101601 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg Item only for testing 4
6 |123456-5 Test ltem 5  Item only for testing 5 541 EUR PC Yes 23240000 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg Item only for testing 5
7 1123456-6 Test ltem & Item only for testing 6 8900 EUR PC Yes 24101635 https://s6.ifotos.plfimg/710ae36da_gawahxa.jpg Item only for testing 6
8 |123456-7 Test ltem 7 ltem only fortesting7 5.31  EUR PC Yes 27111701 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg Item only for testing 7
9 |123456-8 Test ltem & Item only for testing® 8.14 EUR PC Yes 27131512 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg Item only for testing 8
0 123456-9 Test ltem 9  Item only for testing2 6.88 EUR PC Yes 31161500 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg  Item only for testing 9
1/123456-10 Test Item 10 ltem only for testing 10 6.78 EUR PC Yes 31410000 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg Item only for testing 10
2 1123456-11 Test Item 11 Item only for testing 11 6.98 EUR PC Yes 31411700 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg Item only for testing 11
3 123456-12 Test Item 12 Item only for testing 12 1 EUR PC Yes 12161802 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg Item only for testing 12
4 123456-13 Test Item 13 Item only for testing 13 100 EUR PC Yes 12161807 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg Item only for testing 13
5 123456-14 Test Item 14 Item only for testing 14 120 EUR PC Yes 12161809 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg Item only for testing 14
6 [123456-15 Test Item 15 Item only for testing 15 155.15 EUR PC Yes 14111510 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg Item only for testing 15
17

<, CooperStandard
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*Optional field in column AN allows you to paste a URL link to an item’s image — it’s helpful for CS users when

searchingforrequired goods.

AutoSave (@ Off) )

item_list - Excel

AN

Image Url

https://s6.ifotos.

pl/img/710ae36da

qawahx!.]pg

https://sb.ifotos.

pl/img/710ae36da

https://s6.ifotos.

pl/img/710ae36da

https://s6.ifotos.

pl/img/710ae36da

https://s6.ifotos.

pl/img/710ae36da

https://s6.ifotos.

pl/img/710ae36da

https://sb.ifotos.

pl/img/710ae36da

File Home Insert Pagelayout Formulas Data Review View Help  Fuzzy Lookup  Power Pivot © Search
f{j [‘?i’ <t Calibri =11 SAA == = - E‘E;Wrap Text General - ﬁ @ |
Copy ~ -
"5 romarromer | B 1 U E A SEEEE Bueseacon | B-% 9 G4 Srdtowl fomas
Clipboard M Font M Alignment M MNumber M Styles
AN2 - Je
A C D E F G H AN BP

1 |Supplier Part Num* MName* Description™ Price* Currency® UOM code™* active™* Image Url bupplier Item English Name
2 |123456-1 Test ltem 1  Item only for testing 1 100,30 EUR PC Yes tem only for testing 1
3 |123456-2 Test Item 2 Item only for testing 2 15,15 EUR PC Yes tem only for testing 2
4 1123456-3 Test Item 3 Item only for testing 3 2222,30 EUR PC Yes tem only for testing 3
5 |123456-4 Test Item 4 Item only for testing 4 789,99 EUR PC Yes tem only for testing 4
6 |123456-5 TestItem 5  Item only for testing 5 541,00 EUR PC Yes tem only for testing 5
7 |123456-6 Test Item 6 Item only for testing 6 8900,00 EUR PC Yes tem only for testing 6
8 |123456-7 Test Item 7  Item only for testing 7 5,31 EUR PC Yes tem only for testing 7
9 |123456-8 Test Item 8 Item only for testing 8 8,14 EUR PC Yes tem only for testing 8
10 |123456-9 Test Item 9  Item only for testing 9 6,88 EUR PC Yes tem only for testing 9
11 /123456-10 Test Item 10 Item only for testing 10 6,78 EUR PC Yes tem only for testing 10
12 1123456-11 Test Item 11 Item only for testing 11 6,98 EUR PC Yes tem only for testing 11
13 123456-12 Test Item 12 Item only for testing 12 1,00 EUR PC Yes tem only for testing 12
14 1123456-13 Test Item 13 Item only for testing 13 100,00 EUR PC Yes tem only for testing 13
15 /123456-14 Test Item 14 Item only for testing 14 120,00 EUR PC Yes tem only for testing 14
16 |123456-15 Test Item 15 Item only for testing 15 155,15 EUR PC Yes tem only for testing 15
17

https://s6.ifotos.

pl/img/710ae36da

https://s6.ifotos.

pl/img/710ae36da

https://s6.ifotos.

pl/img/710ae36da

https://s6.ifotos.

pl/img/710ae36da

https://sb.ifotos.

pl/img/710ae36da

https://s6.ifotos.

pl/img/710ae36da

https://s6.ifotos.

pl/img/710ae36da

https://s6.ifotos.

pl/img/710ae36da

gawahxd.ipg
gawahxd.ipe
gawahxd.ipe
gawahxd.ipg
gawahxd.ipg
gawahxd.ipg
gawahxd.ipe
gawahxd.ipe
gawahxd.ipg
gawahxd.ipg
gawahxd.ipg
gawahxd.ipe
gawahxd.ipe
gawahxd.ipg

<, CooperStandard
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Link has to be directly to yourimage:

<, CooperStandard

CooperStandard
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All necessary datais in our catalog:

R [ [
wN_IGLDCCI“JO“lU'ILWN—l

RN Ty
N Rn | s

[
-l

A C
Supplier Part Num* Name®
123456-1 Test ltem 1
123456-2 Test Item 2
123456-3 Test Iltem 3
123456-4 Test ltem 4
123456-5 Test Iltem 5
123456-6 Test Iltem 6
123456-7 Test Item 7
123456-8 Test Item 8
123456-9 Test ltem 9
123456-10 Test Item 10
123456-11 Test Item 11
123456-12 Test Item 12
123456-13 Test Item 13
123456-14 Test Item 14
123456-15 Test Item 15

D
Description®
Item only for testing 1
Item only for testing 2
Item only for testing 3
ltem only for testing 4
Item only for testing 5
ltem only for testing 6
I[tem only for testing 7
ltem only for testing 8
Item only for testing 9
ltem only for testing 10
I[tem only for testing 11
Item only for testing 12
Item only for testing 13
I[tem only for testing 14
Item only for testing 15

E
Price*
100.3
15.15
2222.3
789.99

541

8900
5.31
8.14
6.88
6.78
6.98

100
120
155.15

H

] AN

Currency®* UOM code® active® UNSPSC Code Image Url

F
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes

31411904 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
31411905 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
27112838 https://sb.ifotos.pl/img/710ae36da_gawahxa.jpg
44101601 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
23240000 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
24101635 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
27111701 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
27131512 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
31161500 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
31410000 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
31411700 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
12161802 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
12161807 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
12161809 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
14111510 https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg

BP

Supplier Item English Name
I[tem only for testing 1
Item only for testing 2
Iltem only for testing 3
l[tem only for testing 4
Item only for testing 5
ltem only for testing 6
[tem only for testing 7
I[tem only for testing 8
Item only for testing 9
ltem only for testing 10
I[tem only for testing 11
Item only for testing 12
Item only for testing 13
l[tem only for testing 14
Item only for testing 15

<, CooperStandard

19



Now we need to prepare it for an upload into CSP (Coupa Supplier Portal).

10. Press CTRL+H -> Replace all y with =

E

Price*
100,30
15,15
222230
789,99
541,00
8900,00
5,31
8,14
6,88
6,78
6,98
1,00
100,00
120,00
155,15

[+ - T I« L T I N O R N

16
17
18
19
20
21
22
23

A C
Supplier Part Num* Name*
123456-1 Test ltem 1
123456-2 Test Item 2
123456-3 Test Item 3
123456-4 Test ltem 4
123456-5 Test ltem 5
123456-6 Test ltem 6
123456-7 Test Iltem 7
123456-8 Test Item 8
123456-9 Test ltem 9
123456-10 Test Item 10
123456-11 Test Item 11
123456-12 Test Item 12
123456-13 Test Item 13
123456-14 Test Item 14
123456-15 Test Item 15

D
Description®
Item only for testing 1
Item only for testing 2
Item only for testing 3
Item only for testing 4
Item only for testing 5
Item only for testing 6
Item only for testing 7
Item only for testing 8
Item only for testing 9
Item only for testing 10
Item only for testing 11
Item only for testing 12
Item only for testing 13
Item only for testing 14
Item only for testing 15

Price™
100.3
15.15
2222.3
789.99
541,00
8900,00
5.31
8.14
6.88
6.78
6.98
1,00
100,00
120,00
155.15

F
Currency™
rUR
tUR
tUR
-UR
-UR
rUR
rUR
tUR
tUR
-UR
-UR
rUR
tUR
tUR
tUR

https://s6.ifotos.pl/img/710ae36da

gawahxa.jpg

https://s6.ifotos.pl/img/710ae36da

gawahxa.jpg

https://s6.ifotos.pl/img/710ae36da

gawahxa.ipg

https://s6.ifotos.pl/img/710ae36da

gawahxa.ipg

https://s6.ifotos.pl/img/710ae36da

gawahxa.ipg

https://s6.ifotos.pl/img/710ae36da

gawahxa.jpg

https://s6.ifotos.pl/img/710ae36da

G H
UOM code* active® Image Url
PC Yes
PC Yes
PC Yes
PC Yes
PC Yes
PC Yes
PC Yes
PC Ye
PC Ye
PC Ve Find Replace
PC v Find what:
PC Ye
PC v Replace with:
PC Y4
PC Ye

Microsoft Excel

o All done. We made 10 replacements.

X

' Replace All

Replace

gawahxa.ipg

Find All

Find Mext

BP

Supplier Item English Name

Item only for testing 1
Item only for testing 2
Item only for testing 3
Item only for testing 4
Item only for testing 5
Item only for testing 6
Item only for testing 7

Options ==

Close

<, CooperStandard




Please review column E (with prices) to ensure no commas are in place.

If there are no decimal parts you will may need to adjust and add them back in.

=== == Brevace | @ % AH] G e
F Alignment T Mumber T Styles
Decrease Decimal
Show fewer decimal places.
E F G H AN

Price® Currency® UOM code® active® Image Url Supy
EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Item]

EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Item

EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg lten

FUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Iten

EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Item]

FUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Item

EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg lten

EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Iten

EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.ijpg Item]

EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Item

EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg lten

EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Iten

EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.ijpg Item]

EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Itemn]
EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Item

S== = Bvevcncme | @ % 9B 8| G e o
Alignment T Number T Styles
E F G H AN

Price® Currency* UOM code* active®* Image Url Sup
100.3 EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Iten|
15.15 EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Iten
2222.3 EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.ijpg Iten
FUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Iten]

EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Iten|

FUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Iten

EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Iten

EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Iten]

EUR PC Yes https://s6.ifotos.pl/img/710ae3bda gawahxa.jpg lten]

EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Iten|

FUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Iten

“UR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.ijpg Iten

FUR PC Yes https://s6.ifotos.pl/img/710ae3bda gawahxa.jpg Iten]

EUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Iten|

FUR PC Yes https://s6.ifotos.pl/img/710ae36da gawahxa.jpg Iten

<, CooperStandard
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11. Create a backup copy of catalog:

12. Right click on file -> Open with ->
Notepad

<, CooperStandard

Mame

item_list - Copy

item_list

Name

item_list -

item

Date modified

Copy 2020-03-18 10:03

AT A dS Ao A

Open

Print

Edit

Move to OneDrive
7-Zip

CRC SHA

Fu

Scan for viruses

Check reputation in KSN

S

Share
Open with

>£ Excel

Give access to

Restore previous versions

>I .| Notepad

| WordPad

Send to

> E Search the Store
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13. Press CTRL+H -> Replace All y with y -> SAVE FILE & CLOSE

E |

File Edit Format View Help
Supplier Part Num®;Supplier Aux Part Numj;Name* ;Description®;Price®;Currency®;U0OM code*;active®;Item Classification
Name;UNSPSC Code;Lead Time;Manufacturer;Minimum Order Quantity;Order Increment;Contract Number;Contract Term;Savings
#%;Manufacturer Name;Manufacturer Part Number;Price (Tier 1);Price (Tier 2);Price (Tier 3);Price (Tier 4);Price (Tier
5);Price (Tier 6);Price (Tier 7);Price (Tier 8);Price (Tier 9);Price (Tier 1@);Price (Tier 11);Price (Tier 12);Price
(Tier 13);Price (Tier 14);Price (Tier 15);Price (Tier 16);Price (Tier 17);Price (Tier 18);Price (Tier 19);Price (Tier
20);Image Url;Link @ Title;Link @ URL;Link 1 Title;Link 1 URL;Link 2 Title;Link 2 URL;Link 3 Title;Link 3 URL;Link 4
Title;Link 4 URL;Link 5 Title;Link 5 URL;Image © Url;Image 1 Url;Image 2 Url;Image 3 Url;Image 4 Url;Image 5 Url;Use
Pack Weight;Pack Quantity;Pack Weight;Pack wWeight UOM;Receive Catch weight;Item Number;Manufacturer Part Number;SAP
Material Number;SAP ISO UOM;Supplier Item English Name;Supplier Item Item Type;Supplier Item Profit Center;Supplier
Item Deleted?

123456-1;;Test Item 1;Item only for testing

Replace X

3333333 Item only for testing 1;;; Find what |
123456-2;;Test Item 2;Item only for testing

ith: Repl
2;15.155EUR;PC;YRS;55555555553555535555355555 55| Hepacewi | L Beplace | s sisas5555335555s3

I Replace All I

Cancel | Bhgss s s s n s s s ssnasnnssas

]

<, CooperStandard
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It shouldlook like the below:

_| item_list - Notepad _ - »

File Edit Format View Help

bupplier Part Num*®,Supplier Aux Part Num,Name®,Description®,Price®,Currency®,U0M code®,active®,Ttem Classification A
Name,UNSPSC Code,Lead Time,Manufacturer,Minimum Order Quantity,Order Increment,Contract Number,Contract Term,Savings
%,Manufacturer Name,Manufacturer Part Number,Price (Tier 1),Price (Tier 2),Price (Tier 3),Price (Tier 4),Price (Tier
5),Price (Tier 6),Price (Tier 7),Price (Tier 8),Price (Tier 9),Price (Tier 18),Price (Tier 11),Price (Tier 12),Price
(Tier 13),Price (Tier 14),Price (Tier 15),Price (Tier 16),Price (Tier 17),Price (Tier 18),Price (Tier 19),Price (Tier
20),Image Url,Link @ Title,lLink ® URL,Link 1 Title,Link 1 URL,Link 2 Title,lLink 2 URL,Link 3 Title,Link 3 URL,Link 4
Title,Link 4 URL,Link 5 Title,Link 5 URL,Image @ Url,Image 1 Url,Image 2 Url,Image 3 Url,Image 4 Url,Image 5 Url,Use
Pack Weight,Pack Quantity,Pack Weight,Pack Weight UOM,Receive Catch Weight,Item Number,Manufacturer Part Number,SAP
Material Number,SAP ISO UOM,Supplier Item English Name,Supplier Item Item Type,Supplier Item Profit Center,Supplier
Item Deleted?

123456-1,,Test Ttem 1,Ttem only for testing
111@@'BJEURJPCJYESJJJJJJJJJJJJJJJJJJJJJJJJJJJJJJJJhttpS:};86'i{OtOS'pl;img/?lgaeaﬁda_qawahxa'jpg:::::::::::::::::::::
y3333ss1tem only for testing 1,,,

123456-2,,Test Item 2,Item only for testing
2315'15JEURJPC3YESJJJJJJJJJJJJJJJJJJJJJJJJJJJJJJJJhttpS:};SE'ifOtGS'plzimg}?leaeaﬁda_qawahxa'jpgjjjjjJJJJJJJJJJJJJJJJ
s3333ss1tem only for testing 2,,,

123456-3,,Test Item 3,Item only for testing
3J2222'3JEURJPCJYES)}JJJJJJ}JJ}JJJJJJJJJJJJ}JJ}}J}JhttpS:;;56'iFOtGS'plzimg;?leHE35da_qawahxa'jpg}JJJ}JJ}JJ}JJ}}J}}J}
3333333 1tem only for testing 3,,,

123456-4,,Test Item 4,Item only for testing
41?89'991EURJPCJYESJ11JJJJJJJJJJJJJJJJJJJJJJJJJJJJJhttpS:;;SE'iFOtOS'pl/img;?leaeaﬁda_qawahxa'jPEJ:J:J:J:J:JJJJJJJJJJ
3333333 1tem only for testing 4,,,

123456-5,,Test Item 5,Item only for testing

51541}EURJPCJYES)JJ‘JJ‘JJ‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘JhttpS:;;SE'i-FOtOS'pl/img;?‘leaegﬁda_qawahxa'jpg}J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J‘J}J} W

<, CooperStandard



14. Go back to your CSP -> Choose File -> Choose your catalog -> Start Upload

Bulk Load Item Updates for Demo Supplier 1 CSP Catalog 2

Follow these steps to upload items

1. Download the CSV template, or export the current list.
Download ~ or ExportTo -

2. Fill in or update the CSV file. Click here for a description of the required and optional fields in the template.
s Fields marked with a "™ are mandatory.

» Each row uploaded will create a new item.

s Click Start Upload and the system will attempt to load the first 6 rows from your file and show the results.

3. Load the updated file
Choose File | Mo file chosen

Note: If you are loading csv files with non-English characters, please consult the following help note.

‘ Start Upload ‘

MName

33| item list - Copy

3. Load the updated file

Choose File |item_list.csv

<, CooperStandard



15. Verify Data window -> scroll down to the bottom of webpage -> Finish Upload

Verify Data

The first rows of your upload have been loaded. All changes or additions are highlighted in

After reviewing the results, click Finish Upload to continue the upload or Cancel to stop the upload and discard any changes.

Row 1 Row 2

New w

Supplier Part Num”
Supplier Aux Part Num
Name™
Description™
Price™
Currency™

UOM code™

active®

Item Classification Name
UNSPSC Code
Lead Time
Manufacturer
Minimum Order Quantity
Order Increment
Contract Number

Contract Term

<, CooperStandard
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Pack Weight UOM
Net Weight
Net Weight UOM
Receive Catch Weight
Item Number
Manufacturer Part Number

Supplier Item English Name ltem only for testing 5

< CooperStandard

Iltem only for testing 6

srcoupa

Business Spend Management

BA English (US)

© 2006-2020 Coupa Software Incorporated
Privacy Policy - Terms of Use

Finish Upload

Cancel

27



Loading items

Status: Loading »:
Rows Processed: 4

Filename: item_list.csv You should receive a message stating that
“Upload Completed Successfully”

16. After all catalogs rows are loaded correctly
please click “Done”

zscoupa supplierportal

Home  Profile  Orders  Service/Time Sheets  ASN  Invoices = Catalogs  Add-ons

Upload completed successfully

Upload completed successfully. 15 rows processed, creating 15 new rows and updating 0 rows.

Admin

Select Customer

RAFAL ~

Cooper Standard

NOTIFICATIONS @ = HELP ~

Configure Punchout

Done

<, CooperStandard

28



17. You can check your catalog now in CSP. If everythingis correct click “Submit to buyer”. It will automatically
send catalog to CS for an approval.

Save Submit to buyer
Items Included in Catalog
= view
Name Part Number Status Change Price Price Change Currency Other Fields Changed Actions
ITest Item 1 123456-1 New 100.30 EUR X Q
Test Item 2 123456-2 New 15.15 EUR X Q
Test Item 3 123456-3 New 222230 EUR X Q
Test Item 4 123456-4 New 789.99 EUR b Q
Test Item 5 123456-5 New 541.00 EUR b Q
Test Item 6 123456-6 New 8,900.00 EUR b Q
TestItem 7 123456-7 New 5.31 EUR X Q
Test Item 8 123456-8 New 8.14 EUR X @
Test Item 9 123458-9 New 6.88 EUR X Q
Test Iltem 10 123458-10 New 6.78 EUR X Q
Test Item 11 123456-11 New 6.98 EUR X Q
Test Item 12 123456-12 New 1.00 EUR X Q
Test Item 13 123456-13 New 100.00 EUR X Q
Test Item 14 123456-14 New 120.00 EUR b Q
Test Iltem 15 123456-15 New 155.15 EUR b Q
Perpage 15 45 90

<, CooperStandard



Your catalog will now have status of “Pending Approval” and has been sent to Cooper Standard for a

Corporate Buyer to approve.

Catalogs

Catalog was submitted and buyer will be notified.

Catalog Name  Created Date ~ Submitted Date Start Date  Expiration Date Status

Perpage 15 45 80

ITEST Catalog 03/16/20 03/19/20 None MNone

Unanswered Comments Error Actions

Pending Approval | No Q

Your catalog has been accepted by Customer!

Catalogs

ITEST Catalog  03/16/20 03/19/20 MNone None

Perpage 15 45 90

Catalog Name Created Date + Submitted Date  Start Date Expiration Date  Status

Unanswered Comments Error Actions

| Accepted by Customer | No Q

<, CooperStandard
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Customer’s (CS) view of catalog in COUPA.

<, CooperStandard

Test Item 1

from Demo Supplier 1 CSP
Cocpertandard | Sypplier Part 123456-1

Iltem only for testing 1

100.30 Eur Piece Qty

Test Item 3

' from Demo Supplier 1 C5P
CooperStandad | Supplier Part 123456-3

Item only for testing 3

2,222.30 EUR Piece Qty

Test Item 5

' from Demo Supplier 1 CSP
Cooperstandard | Supplier Part 123456-5

Iltem only for testing 5

541.00 EuR Piece Qty

L Test ltem 2

from Demo Supplier 1 CSP
CosperStandand | Supplier Part 123456-2

Item only for testing 2

15.15 EuUR Piece

LJ Test ltem 4

' from Demo Supplier 1 CSP
CooperStandsd | Supplier Part 123456-4

Item only for testing 4

789.99 EUR Piece

L Test ltem 6

' from Demo Supplier 1 CSP
Cosperstandand | Supplier Part 123456-6

Item only for testing 6

3,900.00 EUR Piece

Qty

Qty

Qty

31
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Edition of existing catalog

Some examples:

1. Price updates

2. ltem deactivation

3. Name updates

4. Adding new description

Find backup copy of your existing catalog -> Make another copy (for future catalog updates)—> Open file

Mame Date modified Type Size

|| item_list - Copy - Copy 2020-03-18 10:03 Microsoft Excel Comma Separat.. 4 KB
|| item_list - Copy 2020-03-24 1110 Microsoft Excel Comma Separat.. 4 KB

2020-03-18 10:46 Microsoft Excel Comma Separat.. 4 KB

<, CooperStandard



Mark column A -> Data ->Text to Column -> Delimited -> Next -> Comma -> Finish

<, CooperStandard

File Home Insert Page Layout Formulas I Data I Review View Help  Fuzzy Lookup  Power Pivot O Search
; . = I A
[BFrom Texyycsv [® Recent Sources & [T Queries & Connections ? 5 = E i Flash Fill
[éFrom Web [%Existing Connections @ ﬂ:ﬂ N (9 E!Remove Duplicates
Get Stacks  Geo z| Sort | Filter Text to
graphy | < 4 T ©
Data ~ E From Table/Range | L A‘L EAdvanced Columns [f© Ealaleaiva oy
Get & Transform Data Queries & Connections Data Types Sort & Filter Data Tool
Al - N3 Supplier Part Num* Supplier Aux Part Num,Name* Description® Price® Currency*,UOM code*,active®,Item Classification Name,UNSPSC Code,L|
Increment,Contract Number,Contract Term,Savings %,Manufacturer Name,Manufacturer Part Number,Price (Tier 1),Price (Tier 2),Price (Tier 3),H
(Tier 9),Price (Tier 10),Price (Tier 11),Price (Tier 12),Price (Tier 13),Price (Tier 14),Price (Tier 15),Price (Tier 16),Price (Tier 17),Price (Tier 18),Price (]
A B C D E F G H | J K L M N (0] P Q
10| Supplier Pg§t Num™*,Supplier Aux Part Num,Name* ,Description® Price®,Currency®,UOM code* active®,|tem Classification Name,UNSPSC Code,Lead Time,Manufacturer, Minimum Orde
2| 123456-1, [Pest Item 1 ltem onlv for testing 1100 2 FLIR PC Yes httns://sh ifatas nl/ime/710ae26da nawahxa.jpg, Item only for testing 1,,,
30(123456-2, [Fest Item 1 Convert Text to Columns Wizard - Step 10of 3 ? X @ dPBummmmms'tem only for testing =
4{|123456-3,fest Item , : . Xa.IPE mumummmmmltem only for testi | Convert Text to Columns Wizard - Step 2 of 3 ?
The Text Wizard has determined that your data is Delimited. ) B
50|123456-4,fest Item 4 X8.JDEsmmmmmmmmmmn | t€M only for testi - - P P N o e ——
i A . is screen lets you set the delimiters your data contains. You can see how your text is affected in the preview below.
6}|123456-5,[fest Item If this is correct, choose Next, or choose the data type that best describes your data. D | tem anly for testing 3 y ¥ ¥! P
70| 123456-6,[fest Item §  Original data type PEurmammmnmnitem only for testingf|  Delimiters
8)1|123456-7,[fest Item ]  C i i i G Lo e (0T = DB sssmsimsmmssmmmn 1t€M 0Ny for testing 3 [ 1ab
_ ©§Qelim\ted - Characters such as commas or tabs separate each field. H i -
9{[123456-8, fest 1tem i ] -© uch as P8 item only for testing b = L e By
108 123456-9, [fest Item - Fields are aligned in columns with spaces between each field. IPE sl t€M 0Ny for testing =
170(123456-1(| JTest Ite hXa.J P8, sl te€m only for tesy Text gualifier: | " v
14| 123456-11| fTest Ite hXa. P&, sl tem only for test] LI space
14(123456-12|fTest Ite PBummmmmmnn|tem only for testingly [ other:
14| 123456-12| fTest Ite X8 JPEssrssssssssersmrsnsnenes ) tEM ONly foOr testi i
15| 123456-14 fTest Ite X3P, e €M 0Ny for testi !
15[ 123456-15| JTest Ite Preview of selected data: WahXa.[PE,,.smssssmsssnlt€m only for ts]
17 15upplier Part Mum*,Supplier Aux Part Num,Name*,Description*,Price*,Currency*,UOM cog Data preview
hs 23456-1,,Test Item 1,Item only £or testing 1,100.3,EUR,BC,YS8,,, srrrerrrrrrrrries 1
23456-2, ,Test Item 2,Item only for testing 2,15.15,EUR,PC,YC3,,srerrrerererererers i
19 23456-3,,Test Item 3,Item only for testing 3,2222.3,EUR,BC,Ye2,,,srsrrrrrerrrrrers
20 23456-4,,Test Item 4,Item only for testing 4,789.95,EUR,PC,YeS3,,,srrrrrrrrrrrrrrrr ame escription art Number Price urrency [JOM urchaszable
b1 el 23456-5,,Test Item 5,Item only for testing 5,541,EUR,PC,YCS,rurerurrrrrrrerrrerored ¥V est Item 1 Item only for testing 1 [123456-1 00.30 UR iece [fes
< > est Item 2 [Item only for testing 2 [123456-2 5.15 TR iece [fes
2 est Item 3 Ttem only for testing 3 [123456-3 ,222.30 EUR iece [fes
b3 est Item 4 Item only for testing 4 |123456-% 750.45 UR iece [fes
n Cancel < Back Einish est Item 5 [Item only for testing 5 |123456-5 41.00 UR isce [fes
c < >
Cancel < Back Einish

34



Now ltems list file looks like below.
Supplier is allowed to edit fields, add new items etc.

— ) el
DS ale(e N o slwin =

.

15
16

L B d

A C
Supplier Pe Name*
123456-1 Testltem 1
123456-2 Test ltem 2
123456-3 Test ltem 3
123456-4 Test ltem 4
123456-5 Test Iltem 5
123456-6 Test Iltem &
123456-7 Test Item 7
123456-8 Test ltem &
123456-9 Test ltem 9
123456-1C Test Item 10
123456-11Test Item 11
123456-12 Test ltem 12
123456-13 Test Item 13
123456-14 Test Item 14
123456-15 Test Item 15

D
Description®
ltem only for testing 1
ltem only for testing 2
Item only for testing 3
ltem only for testing 4
Item only for testing 5
ltem only for testing 6
ltem only for testing 7
ltem only for testing 8
Item only for testing ©
[tem only for testing 10
[tem only for testing 11
ltem only for testing 12
ltem only for testing 13

ltem only for testing 14

ltem only for testing 15

E
Price™
100.3
15.15
2222.3
750.45

541

8900
5.31
8.14
6.88
6.78
6.98

1

100
120
155.15

H

AN

https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg

F
Currency* UOM code* active® Image Url
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes
EUR PC Yes

https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg

BP

Supplier Item English Name
ltem only for testing 1
ltem only for testing 2
Item only for testing 3
ltem only for testing 4
Item only for testing 5
Item only for testing 6
ltem only for testing 7
ltem only for testing 8
Item only for testing ©
[tem only for testing 10
[tem only for testing 11
ltem only for testing 12
ltem only for testing 13
ltem only for testing 14
ltem only for testing 15

<, CooperStandard
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List of changes:
Price update for Test Item 1

R wh =

[tem deactivation for Test Item 2

Name updates for Test Item 3

Adding new description for Test Item 5

Price update for Test Item 6

RS . N e
e = A R R S SR S

=t | =l | =l
[=a W, QNN

A C
Supplier P: Name*
123456-1 Test ltem 1
123456-2 Test Item 2

D
Description®
Item only for testing 1
ltem only for testing 2

123456—3' est|tem 3 vl Iltem only for testing 3

123456-4 Test ltem 4
123456-5 Test ltem 5
123456-6 Test ltem &

|123456-7 Test Item 7

123456-8 Test Item 8

123456-9 Test ltem 9

123456-1C Test Item 10
123456-11Test Item 11
123456-12 Test ltem 12
123456-13 Test Item 13
123456-14 Test Item 14
123456-15 Test Item 15

I.Fsm&nhamlnﬁﬁl

tem only for testing 5 with new description

Item only for testing 6
Item only for testing 7
Item only for testing 8
ltem only for testing 9
Item only for testing 10
ltem only for testing 11
Item only for testing 12
ltem only for testing 13
Item only for testing 14
Item only for testing 15

E

15.15 EUR
2222.3 EUR

750.45 EUR

PC
PC
PC
PC
PC
PC
PC
PC
PC
PC
PC
PC
PC
PC
PC

H
Price* Currency® UOM code* active® Image Url

w1

Yes

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

AN

https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg

https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg

https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg
https://s6.ifotos.pl/img/710ae36da_gawahxa.jpg

BP

Supplier Item English Nam

ltem only for testing 1
ltem only for testing 2
ltem only for testing 3
ltem only for testing 4
ltem only for testing 5
ltem only for testing 6
ltem only for testing 7
ltem only for testing 8
ltem only for testing 9
ltem only for testing 10
ltem only for testing 11
ltem only for testing 12
ltem only for testing 13
ltem only for testing 14
ltem only for testing 15

<, CooperStandard
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REPEAT STEPS FROM SLIDES 20-22 AND MOVE TO THE NEXT SLIDE
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Login into CSP -> Catalog Tab -> Create buton -> Load from file -> Choose edited catalog

Catalogs
-> Start Upload

Export ©

Catalog Name Created Date =
Items Included in Catalog S ~
[ Exportto - | view [ v B Advancea ] Search i ioapening
Name Part Number Status Change Price Price Change Currency Other Fields Changed Actions ﬂj item_list - Cup)r
I No rows. tem_list
Perpage 15 45 90
3. Load the updated file
Choose File Iitem_list - Copy.csv I
Note: If you are loading csv files with non-English characters, please consult the following help note.
Row 1 Row 2
A” ChangeS or addltlonS are - I Existing Updated I rExisting Updated |
. . . Supplier Part Num* 123456-1 123456-1 123456-2 123456-2
hlghllghted In . Supplier Aux Part Num
Name* Test Iltem Test Iltem 1 Test Iltem Test ltem 2
1 2
Description® ltem only Item only for testing 1 Item only Item only for testing 2
for testing for testing
1 2
Price* 100.3 1515 1515
Currency™ EUR EUR EUR EUR
UOM code™ PC PC PC PC
active® Yes Yes Yes
Item Classification Name

<, CooperStandard



<, CooperStandard

Price Increase Price Decrease Other Fields Updated

New ltems

Save

Deactivated ltems

Submit to buyer

Row 3 Row § Row 6
IExisting Updated I I Existing Updated I I Existing Updated I
Supplier Part Num* 123456-3 123456-3 Supplier Part Num* 1234565 123456-5 123456-6 123456-6
Supplier Aux Part Num Supplier Aux Part Num
Name* Test Item Name* Test ltem Test ltem 5 Test Item Test ltem 6
3 = 6
Description® Item only ltem only for testing 3 Description® Item only Item only Item only for testing 6
for testing for testing for testing
3 5 6
Price* 22223 22223 Price” 541 541 8,900
Currency* EUR EUR Currency* EUR EUR EUR EUR
UOM code* PC PC UOM code* PC PC PC PC
active® Yes Yes active® Yes Yes Yes Yes
Item Classification Name Item Classification Name
. ] . . ] ] Item only Iltem only for testing 6
After reviewing the results, click Finish Upload to continue the
. 6
upload or Cancel to stop the upload and discard any changes.
Finish Upload Cancel
Upload completed successfully
Upload completed successfully. 15 rows processed, creating 0 new rows and updating 15 rows.
Done
15 Items Changed ( 5 unchanged ) . .
5 CtE Click Submit to buyer
~ R Q1 © e Qo Q
Catalogs

Catalog was submitted and buyer will be notified.
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Edition of existing catalog® (Optional)

Catalogs

Catalog Name  Created Date ¥+ Submitted Date  Start Date Expiration Date  Status Unanswered Comments  Error Actions
ITEST Catalog 2 03/24/20 03/24/20 None None Deleted No Q
TEST Catalog 03/16/20 03/19/20 None None Accepted by Customer No Q

Perpage 15 45 90

Go to catalogs tab in CSP -> Click on
Create buton -> Find item you want

change -> Click on edition buton on view

Items Offered to Cooper Standard

the rlg ht S|de Name Description Part Number Price Currency UOM Purchasable Last Submitted to Buyer Catalog Actions
ITest ltem 1 Item only for testing 1 123456-1 10030 EUR FPiece Yes 03/19/20 TEST Catalog \4
Test ltem 2  Item only for testing 2 123456-2 15.15 EUR Piece Yes 03/19/20 TEST Catalog \4
Test ltem 3 Item only for testing 3 123456-3 222230 EUR FPiece Yes 03/19/20 TEST Catalog \4
Test ltem 4 § Item only for testing 4 123456-4 78999 EUR Piece Yes 03/19/20 TEST Catalog \4
Test ltem 5 Item only for testing 5 123456-5 54100 EUR FPiece Yes 03/19/20 TEST Catalog \4
\4. Testltem 6  Item only for testing 6 123456-6 8,900.00 EUR Piece Yes 03/19/20 TEST Catalog \4
x Ed |t Test ltem 7 Item only for testing 7 123456-7 531 EUR FPiece Yes 03/19/20 TEST Catalog \4
: Test ltem 8  Item only for testing 8 123456-8 814 EUR Piece Yes 03/19/20 TEST Catalog \4

<, CooperStandard



g,2coupa supplier portal RAFAL~ | NOTIFICATIONS @ | HELP- Supplier ltem Attributes

Home Profile Orders

*Part Number 123456-4
Service/Time Sheets ~ ASN  Invoices | Catalogs = Add-ons  Admin

Aucxiliary Part Number

Manufacturer

Lead Tlme :

UNSPSC

Select Customer Cooper Standard ~

Configure Punchout

Test Item 4 Edit Contract |

Pricing Type | Fixed Price ~

* Price] | 78999

* Description | Item only for testing 4 ( “Currency | EUR w

*Name | Test ltem 4

5 Savings %

CooperStandard

item_8966fec2916680db27662076956965e2_710ae36da_gawahxa jpg
(Change, Clear)

* Unit of Measure | Piece ~ Order Increment

Minimum Order
Quantity

Purchasable

Manufacturer Name
English Name | Item only for testing 4

Manufacturer Part
Number

Supplier ltem Attributes

Find field you want to change -
> updated data -> Click Save
button

*Part Number 123456-4
Augxiliary Part Number
Manufacturer

Lead Time

UNSPSC

<, CooperStandard

Contract

Pricing Type

* Price

* Currency
Savings %
Order Increment

Minimum Order
Quantity

English Name

~

Fixed Price

750.45

EUR «

Item only for testing 4

el
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You can review your changes: Price Increase, Price Decrease, Other Fields Updated, New Items and Deactivated
ltems

If everything is correct -> Submit to buyer

1 Item Changed ( 12 unchanged )

o Q1 °2 oo 00

Price Increase Price Decrease Other Fields Updated New Items Deactivated ltems

Save ‘ Submit to buyer ‘

Items Included in Catalog

Name Part Number Status Change Price Price Change JCurrency Other Fields Changed Actions

ITest ltem 4 123456-4 Updated 75045 501 %EUR Image url, Lead Time \ 9

Perpage 15 45 90

<, CooperStandard
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Catalogs

Catalog was submitted and buyer will be notified.

Perpage 15 45 90

Catalog Name Created Date ~ Submitted Date Start Date Expiration Date Status Unanswered Comments Error Actions

Demo Supplier 1 CSP 03/24/20 03/24/20 MNone MNone Pending Approval | No 0

Catalog 4

TEST Catalog 2 03/24/20 03/24/20 None None Deleted No 0

TEST Catalog 03/16/20 03/19/20 MNone MNone Accepted by No 0
Customer

Your changings are waiting for CS approval.

< CooperStandard
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Catalog deletion

Login into CSP -> Catalog tab -> Find
catalog you want to delete -> Click on the
red X buton -> Confirm -> Done

<, CooperStandard

g.coupa supplier portal

Profile

Home Orders

Service/Time Sheets ASN

Invoices

Catalogs

Add-ons

(R S

Admin

Catalogs

Catalog Name  Created Date ~  Submitted Date  Start Date  Expiration Date
TEST Catalog 2 J0324520 03724720 Noni Mone

TEST Calalog  Q3ME20D 0318720 None None

Perpage 15 45

Status
Accepted by Cusiomer

Accepted by Cusiomer

Unanswered Comments
Ny

N

Error _Actions

(x)

ﬂ Delete

Please Confirm

This will remove the item prices associated with this catalog. Are

cance'

you sure you want to continue?

Catalogs

|I Catalog is being deleted

Catalog Name Created Date ~

Submitted Date

Start Date  Expiration Date

TEST Catalog  03/16/20 03/19/20 None None

Perpage 15 45 90

Status

Accepted by Customer

X

o]

Unanswered Comments

No

Error Actions

o
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THE END ‘
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